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Safety Compliance
Safety Statement: (Model #: 9100-65779)

This equipment has been tested to comply with USA, Canadian, EU and International safety certification standards: UL 60950-1 2nd
edition, CAN/CSA C22.2 No. 60950-1-07; 2nd edition, EN 60950-1:2006 /A11, /A1, /A12, /A2 and IEC 60950-1:2005/A1, /A2.

Avid Technology Inc., has been authorized to apply the appropriate NRTL mark on its compliant equipment.

Power Safety Input Rating

Pro Tools | Dock: 12Vdc, 2.5A

Warning

RISK OF ELECTRIC SHOCK
DO NOT OPEN

Important Safety Instructions

1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this equipment near water.

6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance with the manufacturer's instructions.

8) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce
heat.

9) Only use attachments/accessories specified by the manufacturer.

10) Only perform the services explicitly described in the install and or user manual. For services or procedures not outlined in the install
or user manual, speak with authorized service personnel.

11) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as
power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the equipment, the equipment has been exposed
to rain or moisture, does not operate normally, or has been dropped.

12) For products that are a Mains powered device:
The power inlet is the main disconnect device and should remain accessible. Disconnect the power cord before servicing the unit.
Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit
from the equipment.
Unplug this equipment during lightning storms or when unused for long periods of time.

A Warning! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture.
Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the
other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your
safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
This unit may be provided with a power supply cord set suitable for 120V AC input only (for U.S.A.and Canada). For other than
U.S.A. and Canada, a qualified person must provide for use with this unit, an appropriate, approved power supply cord set which is
in compliance with the end use country requirements and has a minimum cross-sectional area of 1.0mm2.



13) For products containing a lithium battery:
A Warning! Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type.

14) For products with a power switch:

It should remain accessible after installation.
15) The equipment shall be used at a maximum ambient temperature of 40° C and maximum altitude of 2000m.

16) For products with an operator-accessible fuse:
CAUTION: For continued protection against risk of fire, replace only with same type and rating of fuse.

ATTENTION: Pour ne pas compromettre la protection contre les risques d'in- cendie, remplacer par un fusible de méme type et de
méme caractéristiques nom- inales.

17) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold
with the equipment. When a cart is used, use caution when moving the cart/equipment combination to avoid injury from tip-over.

18) Rack-Mount Safety Instructions
1) Elevated Operating Ambient - If installed in a closed or multi-unit rack assembly, the operating ambient temperature of the rack
environment might be greater than room ambient. Therefore, consider installing the equipment in an environment compatible with
the maximum ambient temperature (Tma) specified by the manufacturer.

2) Reduced Air Flow - Installation of the equipment in a rack should be such that the amount of air flow required for safe operation
of the equipment is not compromised. Stage 48 airflow is from the front of the chassis enclosure to the rear. Make allowances for
cooling air to be available to the front panel surface and no restrictions at the rear.

3) Mechanical Loading - Mounting of the equipment in the rack should be such that a hazardous condition is not achieved due to
uneven mechanical loading.

4) Circuit Overloading - Consideration should be given to the connection of the equipment to the supply circuit and the effect that
overloading of the circuits might have on overcurrent protection and supply wiring. Appropriate consideration of equipment
nameplate ratings should be used when addressing this concern.

5) Reliable Earthing - Reliable earthing of rack-mounted equipment should be maintained. Particular attention should be given to
supply connections other than direct connections to the branch circuit (for example, use of power strips).
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Introduction

Welcome to the Avid Dock studio controller and tablet dock from Avid®. The Dock uses Avid’s high-speed EUCON™
(Extended User Control) control protocol to enable fully integrated control of Pro Tools® and other EUCON-compatible audio and
video applications via an Ethernet connection.

The Dock is designed to be used with the Avid Control app for iOS and Android tablets. The Dock/Control combination can also
be used simultaneously with up to four S1s, or with one S3, and/or supported Avid Artist media controllers.

This guide shows how to install the Dock and EuControl software, and provides an overview of the Dock control surface.

After installing the Dock and EuControl software, see the Using EuControl Surfaces.pdf for instructions on how to use the Dock
and other Avid media controllers to record, edit, and mix in Pro Tools. Thanks to the EUCON protocol, most steps for Pro Tools
are also applicable in other EUCON-aware applications from our development partners, including Logic Pro X, Cubase, Nuendo,
Pyramix and more (see the EUCON Application Setup.pdf'to learn how to set up EuControl communication with these applica-
tions).

Dock with Pro Tools | Control app on iPad (iPad not included)

EuControl Software

EuControl lets your workstation computer find, link, and communicate with the Dock and Control app via the
EUCON protocol. EuControl also lets you set preferences and customize the controls on your Dock, S1, S3, or Art-
ist series media controller. EuControl software must be installed on the workstation computer before you can use
the Dock with your application. You can also control applications on a secondary workstation computer by install-
ing the separate EUCON Workstation software.
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What’s Included

* Avid Dock control surface

* Power cable and power adapter

» Cat5e (350 MHz) Ethernet crossover cable

» Documentation pack, which includes the EuControl software Activation Card, Dock Welcome Card, Pro Tools | Dock Safety &
Regulatory Guide, Health and Safety Guide, and a warranty card

Additional Required Equipment

* A supported Apple iPad or Android tablet with the most recent version of the Avid Control App from Avid. Avid Control requires
a data (host) connection between the tablet and your primary workstation, using either of the following:
* Wi-Fi*
* Mac only: Apple Lightning to USB 3 Camera Adapter + USB 2 Ethernet adapter connected to iPad running i0S 9.3 .x or later.

A Lightning cable connected to a power source such as the USB port on the Dock is required to power the Camera Adapter.
For more information, visit www.apple.com.

* Android: Samsung Galaxy Tab A SM-T590 USB 3.1 Type C to RJ45 Ethernet Adapter, or equivalent.

Q *The Dock does not provide Wi-Fi; a wireless router is required. For more information, see the Pro Tools | Control Guide.pdyf.

Optional Equipment
» A USB-Ethernet adapter or Thunderbolt-Ethernet adapter, if there is no available Ethernet port on your workstation.

+ If your system also includes an S3, the Dock Link Kit is available to mechanically attach the units. For more information visit
S3-Dock-Link.

System Requirements and Compatibility

One Dock can be used with EuControl Software at a time. In addition, one Dock can be used in conjunction with:
» The Avid Control app and up to four S1s (each with an additional tablet/Control app)
» Or one Avid S3, one Artist Color, and up to four Artist Mix.

* Avid can only assure compatibility and provide support for hardware and software it has tested and approved. For
compatibility information and other resources, visit:
http://avid.force.com/pkb/articles/compatibility/EuControl-Compatibility

Registration

Review the enclosed Registration Information Card and follow the instructions on it to quickly register your purchase online.
By registering, you become eligible to receive the following:

* Technical support information
* Software update and upgrade notices

* Hardware warranty information

About This Guide

This guide shows how to install the Dock and provides an overview of its controls. To learn how to use the Dock with Pro Tools,
see the Using EuControl Surfaces.pdf.

For information about Dock support in DAWs and applications from our Development Partners, contact the manufacturer.
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Conventions Used in This Guide

All of our guides use the following conventions to indicate menu choices and key commands:

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key
Control-click Hold down the Control key and click the mouse button
Right-click Click with the right mouse button

The names of Commands, Options, and Settings that appear on-screen are in a different font.
The following symbols are used to highlight important information:

Q User Tips are helpful hints for getting the most from your system.
A Important Notices include information that could affect your data or the performance of your system.
Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other Avid guides.

Hardware Switches on Avid Control Surface

The names of switches on the Dock and other control surface are shown in bold, such as Sel. The two Surface SHIFT switches
on the Dock are indicated by bold text, in all-caps to distinguish them from references to the Multi Select/SHIFT Global Modifier
switch (S3 only) and the Shift key on your computer keyboard.

Surface SHIFT switches

Accessing Secondary Functions Using Surface SHIFT

The Surface SHIFT switches are used in conjunction with other switches to access a secondary layer of functions. The primary
function of switches are shown directly on each switch. Most secondary functions are listed next to each switch, or on the switch
but in black text with a white background. For example, for the Rec/A switch, Rec (track record enable) is the primary function
and A (track Automation mode) is the secondary function. (You can swap the primary and secondary function for this switch in Eu-
Control).

The following terminology is used to describe Dock SHIFT functions, for example:

To enable Do to All:
* “Press and hold the Dock SHIFT switch then press the Do to Sel/Do to All switch.”

is written as
* “Press SHIFT + Do to Sel/Do to All.”
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How to Use this PDF Guide

These are some useful features of this PDF:

» The Bookmarks on the left serve as a continuously visible table of contents. Click a + symbol to expand that heading to show
subheadings. Click the — symbol to collapse a subheading. Click on a subject heading to jump to that page.

* The Table of Contents provides active links to their pages. Select the hand cursor, allow it to hover over the heading until it
turns into a finger. Then click to locate to that subject and page.

* Any text entry in blue is an active link. Click on the link to go to that section.

 Select Find from the Edit menu to search for a subject.

Resources

The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Avid system.
The following are just a few of the services and features available.

Account Activation and Product Registration

Activate your product to access downloads in your Avid account (or quickly create an account if you don’t have one). Register your
purchase online, download software, updates, documentation, and other resources.

https://lwww.avid.com/account

Support and Downloads

Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Com-
patibility documents for system requirements; search the online Knowledge Base or join the worldwide Avid user community on
the User Conference.

For the Dock visit:
https://www.avid.com/Dock-Support

Products and Developers

Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and
hardware.

https://lwww.avid.com/Products/index.html

Get Started Fast Video Tutorials

Watch the latest video tutorials for the Control app, Dock, S3, and other EuControl products on YouTube:
S3 + Dock Integrated Workflows

For earlier EuControl hardware and software videos, watch the Get Started Fast videos:
Get Started Fast with Pro Tools | S3 and Dock

You can find more videos, including the latest workflow tutorials, on the Avid website. Go to www.avid.com, view Products and
select Pro Mixing. Follow the links for your controller and check the Learn and Support listings for video resources.
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Installation and Setup

This section shows how to get your Dock set up as a studio controller, and consists of the following steps:

* Connecting the Dock

* Installing EuControl Software

* AutoLaunch Settings

* Updating Dock Firmware

* Installing and Connecting Avid Control
* Enabling EUCON in Pro Tools

* Confirming EUCON

Connecting the Dock

Connecting the Dock involves the following steps.
* Connecting Power
* Connecting Ethernet

* Powering the Dock On

Connecting Power

To connect your Dock to your workstation computer:

1 Plug one end of the AC power cord into the power adapter and the other into a power outlet. Make sure the AC power cord is
pushed all the way into the adapter.

Connecting an AC cable to the power adapter

2 Connect the DC output cable from the power adapter to the DC In jack on the back panel. Make sure the connector seats fully
into the DC In jack (you might need to rotate it to align it with the catches inside the jack). Once inserted fully, rotate the cable
connector to lock it in place (optional).

Connecting the power cable to the DC In jack
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Connecting Ethernet

Depending on your configuration requirements, you can connect the Dock directly to your workstation computer (the computer
running Pro Tools or other DAW), to a router or switch that is then connected to your workstation computer, or to an S3 that is con-
nected to your workstation computer.

A Standard routers and switches can be used if you are using the Dock without an S1 or S3, or with an S3 but only using the S3
as a control surface. However, to use the built-in AVB audio I/O on the S3, the S3 must be connected directly to the computer
or to an AVB-compatible Ethernet switch. Visit www.avid.com/Dock-Support for information on compatible peripherals.

To connect Ethernet between the Dock and your workstation computer:

1 Connect one end of an Ethernet Crossover cable into the Ethernet port on the back panel of the Dock.

Ethernet port on the back panel of the Dock

2 Connect the other end of the Ethernet cable to an available Ethernet port on your computer, or to the computer’s Thunderbolt
port using an Ethernet-to-Thunderbolt (or Ethernet-to-USB) adapter.

Or, if your system includes a Dock and an S3 you can connect the Dock to Network port B on the S3, and connect S3 network
port A to your workstation.

A The Dock cannot connect to your workstation computer using a wireless connection. A hard-wired network connection is required.

3 If you want to connect the Dock to a local area network, or to connect additional Artist Series media controllers, connect the
Ethernet cable to an Ethernet router or switch, and make sure the router or switch is powered on before powering on the Dock.

Joining the Dock to $1 or S3

If you are using the Dock with S1(s) see the Avid S6 Guide.pdf for information on joining the units. If you are using the Dock along
with an S3 you can use the S3 Dock Link kit (not included) to securely attach them to each other. The Link kit lets you attach the
Dock to either the left or right of S3 to keep the stable and aligned. You can install the Link Kit at any time. To learn how, see Avid
S3 Dock Link Kit.

Powering the Dock On

To power the Dock on:

1 Press the power switch on the back of the Dock to the “on” position.

The fader jumps and the LEDs blink during initialization.

When the Dock is initially powered on, but not yet attached in the My Surfaces list in EuControl Settings, the LEDs cycle from
dim to light purple. When the Dock is attached in My Surfaces, the 12 switch LEDs in the center light solid purple. When attached
and an application with Soft Keys is focused, the assigned Soft Key colors are shown in the switch LEDs.

2 When the Dock is finished initializing, proceed to Installing EuControl Software.
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Installing EuControl Software
Next, install EuControl software on your workstation computer. The computer running media applications is referred to in this

guide as a workstation. An Internet connection is required to download EuControl.

To install EuControl software:

1 Visit www.avid.com/account and log into your Avid account.

To create an account if you don’t already have one, follow the instructions on the included EuControl Activation card (visit
www.avid.com/redemption, click to select EuControl, then follow the on-screen instructions to create an account.

2 When you are logged into your Avid account, click Avid Software Activation and Download (under My Products).

3 On the Activate Product page, enter your EuControl Activation Code exactly as it appears on your EuControl Activation card
(included in the Welcome packet) then click the Activate Product button.

4 Follow the instructions on-screen to complete your product activation and download the latest EuControl software for your
workstation computer platform (Mac or Windows).

5 When download is complete, locate the EUCON_WorkstationUnifiedInstall on your computer and double-click it to mount it
(DMG on Mac) or uncompress it (ZIP for Windows), then launch the installer.

6 Follow the on-screen prompts until the Installer list is displayed (as shown

) &, Install EUCON Workstatien Unified "]
at right). For a description of each option, select it (Mac) or hover the Gustom nstal on "Macintosh HO*
mouse over it (Windows only). .
License $6 / S4 Workstation skip 77us| |
7 Select each option you want to install: Destinetion Select FLCON Wstalet : '
Installation Type Uninstall all applications Skip B
+ To install EuControl software, select S1/S3/Dock/Control Artist Series. talation
Summary
* Ifyou have already installed EuControl on your primary workstation and
want to install onto an additional, external workstation, select EUCON e e
Workstation (see Connecting a Second Workstation). instal EuConira Software.

8 Click Continue (Mac) or Next (Windows), then click Install.
When reminded that a restart is required, click Continue Installation (Mac)
or Yes (Windows).

AVI> GoBack | | Continue

Installing EuControl onto a primary workstation

9 When installation is complete click Restart.

After your computer restarts, EuControl software launches automatically and is running when its icon (which is unlit until the
Control app is connected) appears in the Menu bar (Mac) or the System tray (Windows).

Q On 10.14/"Mojave” (only) you might need to add Pro Tools and EuControl to the Privacy list in Mac OS System Settings.

Mac Wait up to 60 seconds. A lit EuControl icon in the menu bar indicates correct installation and your surface is attached.

Windows Wait up to 60 seconds. A lit EuControl icon appears in the system tray at the bottom of the screen. If you don't see the
EuControl icon, it could be automatically hidden by Windows. Click on the small white arrow to show hidden icons.

U 8 =
—3 b @
o

L@ 4) = A Fri 3:50 PM|

Customize...

o e—
Lit EuControl icon in the Mac menu bar (left) and Windows system tray (right)
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10 If the lit EuControl icon does not appear, do any of the following:
* See 3 — Add to add the Dock manually.
* Click the unlit EuControl icon and choose Restart EUCON Applications.
* Shut down the Dock and your computer, then turn them on (Dock first, then the workstation computer).

* See www.avid.com/Dock-Support for the most current troubleshooting information.

11 Proceed to Updating Dock Firmware.

To uninstall items:

1 Launch the installer
Items that are currently installed are selected (checked) and indicated as Installed.

2 Do the following:
» To uninstall specific component, make sure it is not selected (no check mark).
* To uninstall all EUCON applications, select Uninstall all applications.

» To uninstall all User Preferences, select Uninstall User Preferences (your appsets will not be removed).

3 Click Continue (Mac) or Next (Windows).

AutoLaunch Settings

You can enable or disable auto-launch for EuControl, WSControl, and/or XMON using the new AutoLaunch selector.
To configure AutoLaunch on Mac:

1 Make sure EuControl or S6 WSControl is installed, then do the following:

Mac Click on the EuControl or WSControl icon in the menu bar.

Windows Right-click on the EuControl or WSControl icon in the System Tray at the bottom of the screen.

S.SI] Wed10:02AM Q=

| EuControl Settings...

+ EuControl Auto-launch Apps »>
MTRX Restart EUCON Applications...
v XMon Collect Support Files...
Quit EuControl #Q

EuControl Auto-launch Apps selector (macOS shown)

2 From the Auto-launch Apps sub-menu, choose any of the following (you can enable more than one):
» EuControl (for the Dock, S1, S3, Avid Control, and Artist Series)
» WSControl (for S4/S6)

+ MTRX (DADMan, for Pro Tools | MTRX and MTRX Studio)
+ XMON
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Updating Dock Firmware
After installing EuControl, make sure your Dock and other Avid media controllers are running the latest firmware. The firmware

is provided within EuControl, so an Internet connection is not required.

To update firmware:

1 Click (Mac) or double-click (Windows) the EuControl icon and select EuControl Settings.
2 Ifnecessary, click Surfaces to display the Surfaces tab.

3 If the Dock is not listed in the My Surfaces list at right, click to select it in All Surfaces and then click Add (or, drag it from
All Surfaces and drop it into the My Surfaces list).

4 Click Avid Dock in the My Surfaces list so it is highlighted.

[ ] EuControl Settings
W Workstetions ~ General  Preferences  Assign  Layouts  Soft Keys
Al Surfaces My Surfaces
Type  Name Claimed By Type  Surface or Master Tablet
Avid Dock (Avid Dock) Ms-Mac-Pro
Remove
Show Info...
Drag surfaces to the My Surfaces list, o select surfaces
and click the Ade butfon
Automatically Add: Update Firmware
My Surfaces only [l

Surfaces tab
5 Click Update Firmware. If the Update Firmware dialog indicates that the surface is up to date, no further action is necessary.

6 If the firmware needs to be updated, follow the instructions in the Update Firmware dialog box to proceed, and make sure to ob-
serve the following guidelines when updating firmware:
» Ensure that the Dock is connected to a trustworthy power source.
* Do not power off the Dock during the update or attempt to interrupt the update.
The status of the firmware update is shown in the EuControl dialog.

7 Click Done when the firmware update is complete, then proceed to Enabling EUCON in Pro Tools.
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Overview of the Surfaces Tab

The Surfaces tab in EuControl Settings shows all EUCON controllers on your network and those connected to your instance of Eu-
Control. Use the Surfaces tab to add and connect surfaces, arrange them in the desired order, pair S1s with Control app tablets and
manage Control app Master/Meters/Hybrid designation.

° EuControl Settings

EHZEE Workstations _General _Preferences _Assign _Layouts _Soft Keys

.

Type  Name Clsimed
Avid $1 (Avid $1-000A) *available*

®

Surfaces tab showing the Avid Control app in All Surfaces (at left) and added to the My Surfaces list (at right)

The Surfaces tab provides the following lists and controls.

1 - All Surfaces

All Surfaces shows all Avid media controllers on the network. A device shown in light gray is already connected either to your own
or another instance of EuControl running on a different workstation. In both cases, it is not selectable.

2 - My Surfaces

My Surfaces shows the media controllers connected to your instance of EuControl. The Type column shows an icon for each de-
vice. The Surface or Master Tablet column shows the name of the device, and for tablets indicates whether Avid Control is func-
tioning in Master, Meters, or Hybrid mode. The top-to-bottom order corresponds to the left-to-right order of the surfaces, respec-
tively. The leftmost surface is assigned to fader strip 1. Use the up and down arrow buttons (located to the right of My Surfaces)
to reorder the list. Each media controller can be renamed by double-clicking the existing name and typing a new name.

3 - Add

Click Add to add the selected All Surfaces entry to My Surfaces. This connects the selected Avid media controller to your instance
of EuControl. You can also click and drag an Avid media controller from All Surfaces to My Surfaces. Add is disabled if all media
controllers in All Surfaces are connected to any instance of EuControl.

4 — Remove

Click Remove to remove the selected surface from My Surfaces and make it available to other instances of EuControl.
Remove is disabled if no surface is selected.

5 - Show Info

Select a unit in All Surfaces or My Surfaces and click Show Info to see the name of the device (and currently linked Control app,
if any), hardware and software information, or troubleshooting suggestions.

6 - Update Firmware

Click Update Firmware to check and, if necessary, update firmware on the hardware control surface currently selected in
My Surfaces. This setting does not apply to Avid Control.

Select a single media controller in the My Surfaces list. Click Update Firmware to update that unit’s firmware. If a dialog displays
a message that the firmware is up to date, no further action is necessary. Repeat for any additional hardware controllers.
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The firmware is embedded in EuControl so an Internet connection is not required.

Follow the instructions in the EuControl dialog box.
* The media controllers must be plugged into a working power source.
* Do not power off any media controllers during the update or attempt to interrupt the update.

* The status for each media controller being updated is displayed on that device as well as in the EuControl dialog.
Artist Control Banks Independently
(Artist Control Only)

This option is only available when an Artist Control is selected in the My Surfaces list. When enabled, each Artist Series unit can
bank independently of each other. In applications that support it, this lets you configure one unit for dedicated control of output bus-
ses, for example.

Q In previous versions of EuControl software the Surfaces tab included the “Automatically Add” menu. This menu has been re-
moved to better support multiple tablets and Control apps.
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Installing and Connecting Avid Control

Before proceeding, make sure your tablet is running the most recent version of the Avid Control app (previously known as
Pro Tools | Control), and that it appears in the My Surfaces list in EuControl. See the Avid Control Guide.pdf for instructions on
installing and connecting the app onto supported iOS and Android tablets.

After you have installed the Control app and connected it to your network, place your tablet in the stand built into the Dock.

» The Dock comes with a Mini Riser pre-installed which increases the viewing angle for iPad Mini and similar tablets, and also
accommodates iPad Air. The Mini Riser can be removed if not needed.

» Ifusing an iPad Air, use a right-angle Lightning cable (not included) to keep the cable clear of the knobs.
* Ifusing an iPad Pro 10.5-inch, you can order the Pro Tools | Dock 10.5” iPad Pro Adapter from the Avid Store.
» Ifusing a larger tablet, the Control app supports portrait as well as landscape display mode.

—

iPad mounted in Dock (shown at left) and removable Mini Riser (shown at right)

To keep your tablet charged, connect your tablet to the USB port on the back of the Dock.

USB port on the back panel of the Dock

Q The back panel USB port is for charging and powering your tablet, only. Data communication with EuControl requires a Wi-Fi
°  connection, Apple Camera Connection Kit and adapters (for iOS), or Samsung Galaxy Tab A SM-T590 USB 3.1 Type C to RJ45
Ethernet Adapter (or equivalent, for Android). For more information, see the Avid Audio Control Guide.pdf.
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Enabling EUCON in Pro Tools

When you first connect your Dock, you must enable EUCON in Pro Tools, EUCON subsequently remains enabled in Pro Tools un-

less you disable it. To enable EUCON in other DAWs, see the documentation provided by the manufacturer.

To enable EuControl in Pro Tools:

1 Launch Pro Tools. If the Dashboard dialog appears, close it.

2 Choose Setup > Peripherals, and click the Ethernet Controllers tab.

3 Select Enable EUCON.

Ethernet Controllers

* [
=[]
» [
» [l
» [

|| Enable

none

none

none

| none

none

none

none

Ethernet Port

-

| 9 Enable EUCON

Enable EUCON check box

A While Pro Tools is connected to a EUCON surface do not uncheck to disable and re-check to enable without a complete restart

of all components (surfaces and Pro Tools computer) after disabling and before re-enabling.

4 Click OK. You do not need to configure any other Ethernet Controllers settings. These settings do not apply to EUCON.

Pro Tools scans your system until it identifies attached EUCON-compatible hardware. When Pro Tools finishes scanning your

system, your controllers are ready to use with Pro Tools.
A Before ever de-selecting Enable EUCON be sure to go to EuControl Settings > Surfaces and remove all attached surfaces.
5 Proceed to Confirming EUCON.

Q To learn how to configure EuControl for other EUCON-compatible applications see the EUCON Application Setup Guide.pdf.

Installation and Setup
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Confirming EUCON

To confirm installation and communication:

1 Make sure you have enabled EUCON.

2 Open a session if one is not already open.

3 Verify that the Tracks or Mixer view in the Control app shows the track names from the Pro Tools session.

BN R ]

Drum Crush

1 E Bass DI 12 E Bass Mic 13 Ak Bass DI 1
Avid Control app Tracks view showing the first 16 tracks in a session

* In the Pro Tools Mix window, verify that the names of the tracks currently banked to the channel strip on the dock (or to strips
on S1, S3 or other Avid control surface if your system includes one) are highlighted with blue-green borders.

vel 0.0f lvel 0.0 {vel 0.00 fvel 0.00 ivol 0.00 ivel 0.0] ivel 0.0 ivel 0.0) fvel 0.0 fvel 0.0f jvel 0.0f ivel 000 lvel 0.0} lvel 0.0) lvel 0.0 lvel 0.0

Pro Tools Mix window showing tracks currently banked to the S3 channel strips

4 Proceed to any of the following:
» To connect a second workstation computer, go to Connecting a Second Workstation.

» To connect a footswitch, go to Connecting a Footswitch.
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Connecting a Second Workstation

The Dock can control applications running on a second computer connected to the same network as the primary computer, referred
to in this guide as a workstation. If EuControl is running on the same workstation as all your audio/video applications you can skip
these instructions.

To be able to control a second workstation:
1 Quit (Mac) or Exit (Windows) Pro Tools and any other EUCON applications running on any of your workstations.

2 Transfer the EUCON_WorkstationUnifiedInstall file onto the second computer. After downloading, make sure the installer is
mounted (DMG on Mac) or uncompressed (ZIP for Windows).

3 Double-click the Install EUCON Workstation Unified installer, then select the EUCON Workstation option and click Next.

EUCON Combined WS Installer PC Configuratjons

following configuratjons.

Checkfuncheck the features to installfuninstall:

[]51 /53 / Dock / Contral / Artist Series
[]s6 / 54 Workstation

———= P [¥]Eucon workstation
DXMOH

I:‘ Uninstall all applications

Remove user preferences

InstallShield

< Back Next > ‘ Cancel

EUCON Workstation selected in EUCON Combined Installer

4 When installation has finished, go to Spotlight (Mac) or Search (Windows), and type “MC Client” to locate the application, then
launch MC Client.
5 On the primary workstation, do each of the following:

» Open EuControl Settings, go to the Workstations tab, and click to enable Enable External Workstations. Follow the prompt
and wait until EUCON applications restart. You must also manually relaunch your DAW.

* Go to System Preferences > EUCON (Mac) or Control Panel > EUCON (Windows), click the Network Interface selector and
choose the port used for your EUCON network connection (such as Ethernet 1).

6 On the secondary workstation, do each of the following:

* Go to System Preferences > EUCON (Mac) or Control Panel > EUCON Preferences
(Windows) Configure EUCON <-> Mackie Apps EUCON Workstation v4.2.5x426
Application Name MIDI Ports
» Make sure the Network Interface selector shows the correct network port for
your EUCON connection.

« Ifit is not already enabled, click to enable Enable as External Workstation.
Follow the prompt and wait until EUCON applications restart. You must also [EE Dekete [ Enable 2s External Warkstation
manually relaunch your DAW. selectNetwark Inerfce

Intel(R) Ethernet Connection [2174M v

7 On the primary workstation, open the EuControl Settings window by doing ei- — o [ can
ther of the following:

* On Mac, click the EuControl icon on the taskbar and select EuControl Settings.

* On Windows, double-click the EuControl icon in the system tray and select EuControl Settings. If you don't see the EuCo-
ntrol icon, it could be automatically hidden by Windows. Click on the small white arrow to show hidden icons, then dou-
ble-click the EuControl icon.

8 In EuControl Settings, go to the Workstations tab.

9 Select your secondary workstation in the All Workstations list, then click Add to add it to the My Workstations list.
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You can now switch between workstations by doing either of the following:

* On the Dock, S3, or other Artist Series media controller, press the Workstation switch. For example, on the Dock press
SHIFT+App/Workstation.

* In the Workstations tab of EuControl Settings, select the desired workstation in the My Workstations list and click Attach. If
you are using the Control app without any other Artist Series controllers, you must use this method to switch workstations.

Connecting a Footswitch

The Dock has a 1/4-inch footswitch input on the back panel, which can be used to punch in and out of recording in your DAW, or
to control Talkback when a supported monitor solution is also connected (such as MTRX or XMON). For more information on con-
figuring the footswitch, see the Using EuControl Surfaces.pdf.

!

Footswitch input on the back of the Dock

Kensington Lock

The Dock provides a Kensington Lock to secure your unit.

Powering-On Your System After Initial Setup
After the initial installation and setup, it is recommended to power up system components in the following order.

1 Router or switch, if any: It is strongly recommended that your router or switch should always be turned on and booted before
anything else.

2 Avid media controllers: S1(s), Dock, S3, tablet(s) and Avid Control app.

3 Computer: If a surface is not recognized by EuControl on your workstation computer, click the unlit EuControl icon in the menu
bar (Mac) or System tray (Win) and choose Restart EUCON Applications...to relaunch EuControl and re-initiate the connection.
See also Troubleshooting EuControl Connections.

Q Ifyou find a different power-up sequence that works for your controllers, computer, and particular configuration, power up in that
" same sequence every time.
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Troubleshooting EuControl Connections

This section provides troubleshooting for EuControl connection issues.

Tablets or Surfaces Disconnecting from EuControl

If your tablets or surfaces are losing connection to EuControl, try the following:
* Make sure the computer is not going to sleep.

+ Restart the Control app(s).

* Turn Wi-Fi off and then back on.

+ Restart tablet(s).

+ Restart EuControl.

“EUCON Network Not Found” Dialog

If the “EUCON Network Not Found” dialog appears when launching EuControl software, you must select the correct Network In-
terface in the EUCON Preferences (Mac) or EUCON Control Panel (Windows).
To select the correct Network Interface for EuControl:

1 Do one of the following depending on your workstation computer’s operating system:
Mac Go to System Preferences and select EUCON.

Windows Go to the Control Panel and select EUCON.

2 From the Network Interface (Mac) or the Select Network Interface (Windows) pop-up menu, select one of the following de-
pending on your configuration:

Wi-Fi When using the Control app standalone (not in conjunction with another Avid media controller).

Ethernet When using the Control app in the following configurations:
» Your workstation computer is connected directly to an Avid media controller such as S3.
* Your workstation computer is connected to a router or switch.

* Your configuration includes a second workstation with EUCON Workstation software installed.
3 In the “EUCON Network Not Found” dialog, choose Restart EUCON.

4 Ifyou chose Quit in the “EUCON Network Not Found” dialog, relaunch EuControl by typing “EuControl” into Spotlight Search
(Mac) or the Start Menu Search box (Windows), then choose EuControl.

Unlit EuControl Icon

If a lit EuControl icon does not appear when EuControl launches, do any of the following:
* See 3 — Add to add the Control app manually.
¢ Click the EuControl icon in the menu bar (Mac) or right-click the choose Restart EUCON Applications.
* Shut down the tablet and your computer, then turn them on (tablet first, then the workstation computer).
» Make sure the name of your tablet does not exceed 31 characters.

» See http://avid.force.com/pkb/articles/faq/Avid-Control-Support for the most current troubleshooting information.
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Dock Surface Controls Overview

This section provides an overview of the surface controls on the Dock when using it with the Control app and EUCON-compatible
applications.

For audio workflows, see the Using EuControl Surfaces.pdf.

Avid Dock top panel
1 - Tablet Stand 6 — Wheel and Horizontal Touchstrip
2 — Soft Knobs 7 — Transport
3 - Soft Keys 8 — Channel Strip
4 — Left Control 9 — Control Room/Monitor
5 — Right Control and Vertical Touchstrip 10 — Surface SHIFT
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Tablet Stand

Provides a stand for securely mounting a compatible iOS or Android tablet (not included) running the Avid Control app. The Con-
trol app can be used in landscape (wide) or portrait (tall) mode. The included Mini-Riser increases the viewing angle for smaller
tablets such as the iPad Mini, or it can be removed to fit larger tablets in the stand. The Soft Knobs surrounding the tablet stand
correspond to controls on-screen in the app, as do the Soft Keys below the stand.

Tablet stand (1), Soft Knobs (2), and Soft Keys (3)

A back panel USB port lets you charge your tablet while in the Dock. This USB port is for charging, only, it is not a data/host con-
nection.

Soft Knobs

These eight touch-sensitive encoders provide parameter control over the currently focused knobset displayed in the Control app,
such as EQ or Dynamics controls in Channel view, and pan controls in Mixer or Channel view. The Soft Knobs are dual-function
encoders that can be rotated to select and adjust values, and pressed to toggle certain functions.

Q The term “knobset” refers to different sets of parameter types, such as input, EQ, Dynamics, and sends.

Working with different knobsets from the Soft Knobs requires just a few simple steps:

1 Select or attention a track, or select a function or parameter.

For example, on the iPad use Channel view to attention a specific track and function. Or from an S3, press a Channel Encoder
Assign switch to focus that function (such as EQ). The Control app displays available parameters for the track or function.

2 To navigate to or select a track parameter or other choice shown on the iPad screen, press the Soft Knob next to that choice.

3 To adjust a parameter shown on the iPad, rotate a Soft Knob. Rotating slowly adjusts in small increments (“fine” resolution); ro-
tating faster adjust in larger increments.

Soft Knobs surrounding the Control app in Channel view, EQ selected
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Soft Keys

These sixteen switches engage the corresponding Soft Key assignment in the Control app. Default (factory) Soft Key assignments

are available automatically, and you can customize assignments using the Soft Key Editor in EuControl Settings.

Soft Keys shown in Mixer view

1] 1] 000

In the default Pro Tools appset, the two Soft Keys at the far left are assigned to the Fader and Soft Keys buttons. The two Soft Keys
at the far right are assigned to A and v, which scroll the displayed Soft Keys up or down, respectively. The twelve switches in the
center are assigned to the Soft Keys shown across the bottom of the Control app screen.

Q The 16 Soft Key switches on the Dock are separate from the Soft Keys view in the Control app, which provides multiple pages of

Soft Keys, each with four rows of six Soft Keys. For more information Soft Keys, see the Using EuControl Surfaces.pdf.

Left Control

These twelve switches provide dedicated automation controls.

Preview

Punch
Preview

Suspend

Preview

Capture

Punch
Capture

Dock Surface Controls Overview

All/Sel

Primary switch functions include track Automation mode selectors such as Write,
Touch, Latch, Touch Latch, Trim, Read, Join, Auto Join, Suspend, Off, and
(Automation) Window. These switches let you select the corresponding Automation
mode for the currently attentioned track, all selected tracks, or all tracks. By default,
the switch LEDs in the Left Control section indicate track automation modes globally
for the session. For example, if the session contains some tracks in Read and other
tracks in Touch automation modes, the Read and Touch switch LEDs on the Dock are
lit. You can instead have switch LEDs only indicate automation mode for the cur-
rently attentioned track using the Dock Automation Mode Buttons Follow Atten-
tioned Channel setting in EuControl Settings.

Secondary switch functions, accessed by enabling the ALT switch, provide advanced
automation commands including Preview, Punch Preview, Suspend Preview,
Capture, Punch Capture and AutoMatch, as well as Write To... commands
(All/Sel, Start, End, Punch, and Next). The ALT switch is a latching “page 2”
switch that only affects the switches in the Left Control section. Using ALT lets you
select advanced automation functions while still being able to access primary or sec-
ondary switch functions in other sections.

For complete information on how to assign track Automation mode, and how you can
optimize switch and LED behavior, see the Using EuControl Surfaces.pdf.
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Right Control and Vertical Touchstrip

These twelve switches include controls for navigation (such as Bank and Nudge), Wheel modes (such as Jog, Shuttle, Zoom,
and Scroll), and utility controls (such as OK, Cancel and the App/Workstation switch).

The EUCON Show Me icon is shown between the Save and
Cancel switches. Pressing Save + Cancel simultaneously
shows Soft Key assignments in EuControl.

| Nudge >
VerticalTouchstrip
To the right of the switches is a vertical, continuous Touchstrip

with four zones labeled 1, 2, 3, and 4 from top to bottom. By
default, these zones are assigned to the following functions:

Touchstrip (vertical) primary and SHIFT functions
Zone Primary Layer SHIFT Layer
1 System Usage Preferences

2 Toggle Child Folders Task Manager

3 Toggle Sibling Folders | Workspace

4 Toggle Folders Video window

For information on how you can customize the touchstrip, see the Using EuControl Surfaces.pdf.

Wheel and Horizontal Touchstrip

The Wheel can be used to jog, shuttle, scroll, and zoom, mark in and out
points, move selections, and adjust clip gain, as determined by the Wheel
mode switches in the Right Control and Vertical Touchstrip section.

Below the Wheel is a horizontal continuous Touchstrip with four zones la-
beled 1, 2, 3, and 4 from left to right. By default, these zones are assigned to
the following functions:

Touchstrip (horizontal) primary and SHIFT functions

Zone Primary Layer SHIFT Layer
1 Toggle Folders Mix/Edit Window toggle
2 Toggle Sibling Folders Hide All Floating Windows
3 Toggle Child Folders Memory Locations Window
4 System Usage System Usage Window

For information on how you can customize the touchstrip, see Using EuControl Surfaces.pdyf.
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Transport

These seven switches provide basic Transport commands RTZ (Return to Zero), Rewind, Fast Forward, Stop, Play, Record, and

Loop on/off in their primary layer, and extended Transport commands in the SHIFT layer.

sack> B« M > W usex W PrRoLL

The following table lists all the primary and secondary functions of the Transport switches.

Transport switches, primary and SHIFT functions

Primary Layer SHIFT Layer
|I< (Return to Zero) Back + Play
<< (Rewind) Previous
>> (Fast Forward) Next
[ (Stop) User (assignable in EuControl)
> (Play) Pre/Post-Roll on/off
O (Record) Record Mode
Loop (playback) Loop Record

Channel Strip

The Dock provides one channel strip with a Solo switch, a Mute switch, a 100mm motorized touch-sen-
sitive fader, a channel select (Sel) switch, a Record Enable (Rec)/Automation Mode (A) switch, and a
level meter.

Solo

The Solo switch lights yellow when that track is soloed.

Mute

The track is muted (off) when the strip Mute switch is lit, and is on (unmuted) when not lit.

Fader

The fader controls the level for the track assigned to the channel strip. It is motorized so it reflects changes
made in the application, such as automation. It is also touch sensitive, which some applications use for au-
tomation.

+ When the Select by Touch General preference is selected in the General tab of EuControl Settings ap-
plication, touching a fader selects that track in the application and attentions it on that strip. This is the
same as pressing the fader Sel switch.

+ Holding down the Option (Mac) or Alt (Windows) key on your computer keyboard and touching a
fader sets it to unity gain.

+ Holding down Surface SHIFT and touching the fader also resets it to unity.

Q On systems that include an S3 or other controller, the Dock fader ignores fader Flip.

Dock Surface Controls Overview
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Channel Sel and Rec/A Switches

The channel strip features channel Sel and Rec/A switches that operate as follows:
Sel Selects that track in the application, and attentions it.

(¥ In Pro Tools and other applications, multiple tracks can be selected, but only one can be attentioned. In this case, the attentioned
track is the last one selected.

Rec/A Record-enables a track in the application.
* In Pro Tools, the Rec switch flashes red to indicate that track is enabled (armed) for recording, and is lit solid when recording
is in progress.

» Pressing a lit Rec switch disables that track for recording.

A (SHIFT + Rec/A) Changes the automation mode for a track.The selected automation mode appears in the channel strip (Mixer
view) and Track tile (Tracks view) on-screen in the Control app.

Configuring the Rec/A Switch Priority

You can swap the default function of this switch in EuControl. When swapped, the default function (without SHIFT) changes the
track automation mode, and the SHIFT function record enables the track. For more information, see the Using EuControl Sur-

Jaces.pdf.

Control Room/Monitor

This encoder defaults to Control Room level, and its SHIFT function to Monitor level in supported applications. The Monitoring
page in the Pro Tools Control app lets you assign and manage monitor controls. The Monitoring page supports any hardware or soft-
ware application with a EUCON Monitor, such as Pro Tools | MTRX, Avid XMON, Studio Monitor Pro 2, as well as Nuendo, Cu-
base, and Pyramix.

Main Level and Cut (mute) are also supported in Pro Tools without MTRX or XMON (requires Pro Tools 18.7 or higher) when you
use the Enable EUCON Monitor feature. For more information, see the Using EuControl Surfaces.pdf.

Control Room

Surface SHIFT

Most switches have secondary functions that are shown next to each switch (such as Bank/<Nudge, where <Nudge is the sec-
ondary function). To access these secondary functions, use either of the two SHIFT switches located at the lower-left and
lower-right sides of the Dock. SHIFT can be engaged momentarily or latched on.

Surface SHIFT switch

To engage Surface SHIFT momentarily:

= Press and hold the Surface SHIFT switch.

To latch SHIFT on:

1 Open EuControl Settings and navigate to the Preferences tab.

2 In the Miscellaneous section, enable Latching Shift.
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Appendix A: Specifications

All specifications subject to change.

Module: Avid Dock

Mechanical

Avid Dock Mechanical Specifications

Parameter Specification
Dimensions (L x W x D) 14.1 x 13.87 x 5.4 inches (height at back)
359 x 352 x 138 mm
Weight 4.17 Ibs
1.89 kg
Power Requirements 25A
Ethernet Port 1000-BaseT (Gigabit) Ethernet RJ-45
Environmental

Avid Dock Environmental Specifications

Parameter Specification Limit Units Condition/Comment
Storage Temperature —18 to +60 deg C deg C Oto+140deg F
Operating Temperature +4 to +40 deg C deg C +40 to +104 deg F
Storage humidity range 5to0 95 % Non-condensing
Operating Humidity Range 20 to 80 % Non-condensing
Continuous Vibration (Storage 1 g RMS Random spectrum
only: non-powered transportation)

Appendix A: Specifications
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Test Mode

The Dock has a self-test mode that lets you test the fader, LEDs and knob touch-sensitivity. This self-test mode is similar to “Vegas
Mode” on other control surfaces.

To enable Test Mode on the Dock:

1 Power the Dock off.

2 Press and hold down both Bank switches (< and >) simultaneously while powering the Dock back on.

On the Dock, all LEDs light and cycle through their color range.

 Press any switch and you will see all LEDs change to the Yellow/White range.
+ Test the touch-sensitivity of the knobs. Tapping a knob will switch the LEDs to the Yellow/White color range.

* Rotate the top-left knob to change the speed of the fader cycle.

* Touching the fader will cause it to stop cycling.

Note that not every LED will light up with certain colors. For example, in the Blue test the Write, Latch, and Trim LEDs (among
others) will stay unlit. In the Yellow/White test some of the LEDs will appear Yellow and others appear White.
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Appendix B: Avid S3 Dock Link Kit

If you are using the Dock along with an S3, you can use the Avid S3 Dock Link kit (not included) to attach them to each other. The
Link kit lets you attach the Dock to the left or right of S3 to keep them stable and aligned. You can install the Link Kit at any time.

Oy If you are using one or more Sls with the Dock you can use the S1 Link plate included with each S1. For more information, see
the Avid S1 Guide.pdf.

Installing the S3 Dock Link Kit

The following sections explain each of the steps required to install the Link Kit. The examples show an S3, but installation for S1
is similar.

* Collecting the Required Items

* Getting Started

+ Installing the Spacer Plates

» Attaching the Foot Bracket

* Installing the Link Plate

» Attaching the Dock to the S3

Collecting the Required Items

Installing the Link Kit requires the following additional items that are not included in the kit:
» #1 Phillips screwdriver.
» A padded surface large enough to be able to place the S3 face down.

» Two blocks to set the S3 on during installation. Both blocks should be at least 1-inch wide, 1-inch tall, and 8-inches long.

Getting Started

To begin, unpack the contents of the Link Kit and then prepare the S3 for installation.

To get started installing the Link Kit:
1 Decide how you want to arrange your Dock and S3 (Dock to the left of S3, or to the right of S3).

2 Unpack the Avid S3 Dock Link bracket and other components, shown in the following figure.

®

® O

Figure 1. Link Plate, Spacer Plates, and Foot Bracket

In the following table, numbers refer to the figure, above.

Appendix B: Avid S3 Dock Link Kit 26



Contents of the S3 Dock Link Kit

Number | Item

1 Link Plate
2 Spacer Plates (2x) with adhesive backing
3 Foot Bracket

not shown | Fasteners (2x Phillips, M3 x 12mm, flat head)

3 Turn the S3 over and slowly set it face down on a padded surface, being careful not to let the unit drop (this could damage the
encoders and faders). The following is recommended:

*  When turning the S3 over, orient it so that its back panel (with ports and connectors) is closest to you. If the front (with head-
phone level control) is closest to you, the left and right sides will be reversed relative to when the unit is facing up.

»  We strongly recommend using blocks placed at both ends of the unit when facing down, similar to the figure below, to prevent
the unit from resting on its encoders and faders.

Q Instead of blocks, you can also use the foam packing included in the original S3 package.

Figure 2. Placing the S3 on blocks to protect the encoders and faders

Installing the Spacer Plates

To install the S3 Spacer Plates:
1 Take one of the Spacer Plates and remove its adhesive backing.

2 Making sure the adhesive backing is oriented towards the S3, align the holes in the Spacer Plate with the two fasteners on the
underside of the S3, and attach the Spacer Plate to the left or right of the S3 as shown below.

Two Spacer Plates are included so that you can attach one to both the left and right sides of S3 to simplify re-arranging the units.

L 2
_’@: F ﬂﬂHH[E@ﬂIﬂﬂHﬂﬂﬂllﬂﬂlﬂﬂ@]lﬂﬂlﬂﬂ”ﬂﬂﬂﬂﬂ@HHH"HIHHH“@I\H” :°‘_

Figure 3. Spacer Plates installed on both the left and right sides
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Attaching the Foot Bracket

Next, attach the Foot Bracket to the front corner of the underside of the S3. The figures below show the Foot Bracket being installed
to have the Dock to the right of the S3 (when turned right-side up for use). If you want the Dock to the left of the S3, the basic steps
are the same. The Foot Bracket is reversible and can be attached to either side of the S3.

To install the Foot Bracket:

1 Using a #1 Phillips screwdriver, remove the two screws indicated below, as appropriate for which side you want the Dock.

o] IﬂIH'HIﬂlﬂﬂﬂﬂIﬂﬂﬂﬂﬂ'ﬂIﬂﬂﬂﬂﬂHIHHﬂ'HHHMHIHHMH'IHH

i' T e v g
o

Figure 4. Removing screws from the S3

2 Attach the Foot Bracket to the S3 by orienting it as shown below.

* Place the hole in the Foot Bracket over the foot of the S3 as shown below, then align the bracket with the receiver holes for
the screws you removed previously.

» Secure the Foot Bracket to the S3 using the included M3 x 12mm fasteners.

Q If you have a case in which you pack your S3 for travel, or if you expect to alternate which side you want to have the Dock, you
" do not need to secure the Foot Bracket to the S3 with fasteners. Just keep in mind it can fall off when lifting the S3.

o I

j TR

[ W“WQ

Figure 5. Attaching the Foot Bracket to S3

o of ®
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Installing the Link Plate
The Link Plate is held magnetically to the underside of the S3.

To install the Link Bracket:

= Orient the Link Plate and align its pins with the holes in S3 as shown below (1 in Figure 6), then place it against the underside
of the S3 (2 in Figure 6).

The bracket is magnetic and requires no fasteners to attach it.

Figure 6. Attaching the Link Plate to S3

Attaching the Dock to the S3

With the Foot Bracket and Link Bracket attached to the S3, you are ready to turn the S3 back over and attach the Dock.

To attach the Dock to S3:
1 Turn the S3 over so it is once again facing up.

2 Bring the Dock next to the S3 on the side where you installed the Link Kit, and line up the front foot of the Dock with the re-
ceiving hole on the Foot Bracket.

3 Set the Dock down so its front foot rests in the Foot Bracket, and its notches are seated fully on the on the short pins and blocks
of the Link Plate.

(

oo ao
BD 5050505050505050F0FCECECF0F0F050 0
oo | ] oo
oo ao
B0505050505050505050505050505050 i
S oooooooooooooooo 28
EE@@@@@@@@@@@@@@[B@BB
o 0a 0o
00 ao
00 o a ofelelJe]oJaolaelo oflo a0 o 8o (s ]}
oo b|o|o|e|e|e|e|o|o|ole|o|ja|jo|lo|o oo ] oo oo
oo ao oo oo
oo 5 slelalalals BERE ao g oo oo
S R R AR RE R R R RR R R oo i
e -] c" o0 e e 0’ e’ e 0’ e e e*e"e e [OQO oo OoOooo
®© 06 o o o ——> 0o o ]
J J

Figure 7. S3 and Dock, linked
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Appendix C: Compliance Information

Model Name: Avid Dock Model #: 9100-65779

Environmental Compliance

Disposal of Waste Equipment by Users in the European Union

A

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your
responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste elec-
trical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help con-
serve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more infor-
mation about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the
dealer from whom you purchased the product.

Proposition 65 Warning

This product can expose you to chemicals including Pb and Pb compounds, which is known to the State of Cali-
Vi n \ WARNING . . .

fornia to cause cancer and birth defects or other reproductive harm.

For more information go to www.P65Warnings.ca.gov.

Perchlorate Notice

This product may contain a lithium coin battery. The State of California requires the following disclosure statement: “Perchlorate
Material — special handling may apply, See www.dtsc.ca.gov/hazardous waste/perchlorate.”

Recycling Notice

4y
e
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EMC (Electromagnetic Compliance)

Avid declares that this product complies with the following standards regulating emissions and immunity:
* FCC Part 15 Class B
+ EN 55022 Class B
+ EN 55024
* AS/NZS CISPR 22 Class B
» CISPR 22 Class B

FCC Compliance for United States

Radio and Television Interference

Communication Statement

NOTE: This equipment has been tested and found to comply with the limits for
a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a res-
idential installation. This equipment generates, uses, and can radiate radio fre-
quency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equip-
ment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try
and correct the interference by one or more of the following measures:

« Reorient or locate the receiving antenna.

« Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

« Consult the dealer or an experienced radio/TV technician for help.

Any modifications to the unit, unless expressly approved by Avid, could void the
user's authority to operate the equipment.

Australian Compliance

Lo

Canada ICES-003 Compliance

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe B respecte toutes les exigences du Réglement sur le material brouilleur du Canada.

Korea Class B EMC Compliance
017171 7H8E (B 2 ) MAMIHEI|7I2M F 2 71H0lIM ARSI W2 SHO2 510, 2  XIH0lIAM AKSE 4= YUBLIC.

Japan VCCI B Compliance

D%, 77 ABIRRRAMEE T CORBER. RERRK CER
THZLEBRELTVETH, COREF VA PTLES 3 - REH#IC
HELTERSNSE, SEREBESIZRITIEN BN ET,

RS AR ICRES>TELVEWRWELTTE W, VCCI-B

CE Compliance
(EMC, Safety and RoHS)

C€.

Avid is authorized to apply the CE (Conformite Europenne) mark on this compliant equipment thereby declaring conformity to
EMC Directive 2014/30/EU, Low Voltage Directive 2014/35/EU and RoHS Directive 2011/65/EC.
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